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Questions and Answers: 

Q: Do you have to download a QR scanner app to connect with the MimioMobile™ app? 
A: No additional software is needed to scan a QR code. MimioStudio™ classroom software has 
everything you need built in, making it easy to connect the teacher and student mobile devices. 

Q: Where is the QR code to connect teachers and students? 
A: Download our MimioMobile Connecting Guide to learn how to connect the teacher and student 
mobile devices using the MimioMobile™ app. More helpful resources can be found at 
http://www.mimio.com/en-NA/Training/Overview.aspx.   

Q: Can I install the MimioMobile app on my smartphone and on iPad tablets? 
A: Yes. With the MimioMobile app, you can use any combination of Android and Apple devices at the 
same time. The MimioMobile app supports iPad 2, iPad 3, iPad 4, iPad mini devices, iPhone (4th 
generation and higher), iPod Touch (4th generation and higher), and Android 3.0 (Honeycomb) tablets 
and smartphones.   

Q:  Can you use the MimioMobile app on laptop computers? 
A: Although you can install and run MimioStudio software on student laptops for them to use, the 
MimioMobile app is designed only for mobile devices. Only a teacher laptop running MimioStudio 
software and the licensed MimioMobile features will be able to interact with student mobile devices 
that have the MimioMobile app. Student laptops will not be able to use the Collaborate features as they 
would on a mobile device, since this is not how the app was designed or intended to be used. In order to 
use the MimioMobile license, the teacher’s computer must have MimioStudio software installed. In 
addition, student mobile devices and a teacher mobile device have to be enabled with the free 
MimioMobile app to be able to interact throughout the classroom. 

Q: Our school has many MimioTeach™ bars, so can we get MimioStudio software and the 
MimioMobile app for free? 
A:  MimioStudio software can be downloaded for free from http://mimio.com/support/downloads. The 
MimioMobile app is a free download from the Apple or Google Play stores. If you use MimioStudio 
software without any Mimio products attached to your computer, you will have some limitations. You 
will still be able to create and open Mimio lessons, but presentation tools and the MimioMobile app will 
be disabled. Using the latest version of MimioStudio software on your PC, Mac, or Linux computer, you 
can connect up to three mobile devices via the MimioMobile app at no extra cost. You need to be using 
a licensed version of the MimioStudio software, which will be the case when you attach any Mimio 
product to your computer. You could use the MimioMobile app with three student devices, or you could 
connect your teacher mobile device and two additional student devices. While the free license is limited 
to three users, there is no time limit on this feature, as long as you are running a licensed version of 
MimioStudio software. If you decide that you want more than three students using the MimioMobile 
app simultaneously, you will need to purchase a MimioMobile license. Since it sounds as though many 
of your teachers are using a Mimio product, you already have immediate use of at least three 
MimioMobile-enabled devices. 

https://mimio.adobeconnect.com/p8xjtdnj0tg/
http://www.mimio.com/~/media/Files/Downloads/Support/Documentation/MimioMobile/MimioMobileConnecting_MS11.ashx
http://www.mimio.com/en-NA/Training/Overview.aspx
http://mimio.com/support/downloads
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Q: Are the tools that students are using with the MimioMobile app part of the Mimio tools, or are 
they on each device? 
A: Students have access to the tools built into the MimioStudio software that is running on the teacher 
computer. You will find the same familiar icons and features. While in the Collaborate mode, students 
can access only a limited set of tools, which include the selector, pen, highlighter, and eraser. When 
students are in the Control mode, they have access to all features and tools in the software and on your 
computer, as you wish. 

Q: How can I get the MimioVote™ questions on the mobile devices? 
A: In order for any MimioVote question to be sent to a mobile device, you first have to create a question 
in the MimioStudio software.  You can use one of the various question templates that can be found in 
the MimioStudio Gallery or conduct a Quick Vote session.  Once your MimioMobile enabled mobile 
devices are connected to the teacher computer, the answer choices for questions will appear on the 
mobile devices when you begin polling.  Find out more about using the MimioVote assessment system 
and MimioMobile in our Quick Learn sessions.  We have full training sessions on creating MimioVote 
assessments as well as using the MimioMobile app. 

Q: How do I show the students working on the screen? Is there a maximum number that can be 
shown? 
A: When using the Collaborate mode with MimioMobile enabled mobile devices, each individual 
student’s mobile device will show on the front-of-room display. You can have up to 50 students 
collaborating at the same time.  With the new features available in MimioMobile, you can choose to 
hide the screen at the front of the room, pause activity, and select any number of student mobile 
devices to be shown on the screen.  Find out more in our Mimio Goes Mobile Quick Learn session or 
from our MimioMobile Toolbar Reference card. 

Q: How many teachers can use a license for the MimioMobile app? 
A: When you install MimioStudio software on your teacher computer and it’s activated by connecting 
any Mimio product, you can use the MimioMobile app with any mobile device in your classroom that 
connects with that one teacher computer. The license is per computer on which MimioStudio software 
is installed. If every teacher has MimioStudio software installed on his or her computer and uses a 
Mimio product, they all can make immediate use of the MimioMobile app in their classroom. 

Q: Is the cost of the MimioMobile app a one-time fee? Does the MimioMobile license expire? 
A: An annual classroom license, which allows all mobile devices to connect to the teacher computer, is 
$199. A school site license is $2699. It is an annual license and it will expire after one year, once it’s 
activated. If the license isn’t renewed, it will revert back to the lite version, allowing you to use it with up 

to three mobile devices in your classroom. You can purchase the license through your Mimio salesperson 

or your local reseller. To find the reseller or Mimio sales rep nearest you, visit 
http://www.mimio.com/en-NA/Purchase/Resellers.aspx.  

 

 

 

http://mimio.com/QuickLearn
http://mimio.com/QuickLearn
http://www.mimio.com/~/media/Files/Downloads/Support/Documentation/MimioMobile/MimioMobileToolbars_MS11.ashx
http://www.mimio.com/en-NA/Purchase/Resellers.aspx
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Q: How many mobile devices can be connected at one time when using the MimioMobile app?  
A: There is no limit to the number of devices that can utilize the MimioMobile app with a teacher 
computer that has a licensed version of MimioStudio software. However, the number of students that 
can take part will vary. When using any assessment mode, an unlimited number of students can take 
part using their mobile devices. Additionally, the Control mode can be used with an unlimited number of 
students, but the teacher can give complete control of any lesson to only one student at a time. When in 
the Collaborate mode, you can have up to 50 mobile devices taking part in collaborative lessons. 

Q: Can I use my personal mobile device in my classroom as an interactive device? 
A: Yes. Using a teacher mobile device as your own interactive tool is possible as long as you are using a 
licensed version of MimioStudio software on your teacher computer, you have the MimioMobile app 
installed on a supported mobile device, and all devices are on the same network. Many teachers use 
their existing mobile device in this way to interact with their computer and their lessons. Using your 
MimioMobile-enabled mobile device, you can have complete control over everything you want to do on 
your computer, while being out among your students. 

Q: What if we don't have a Mimio product – just the Mimio software? Can I still use the MimioMobile 
app? 
A: The lite (free) version of the MimioMobile app is only possible if you have a licensed version of 
MimioStudio software. If you don’t have a Mimio product, you can purchase a software license just for 

MimioStudio software. You can purchase the license through your Mimio salesperson or your local 

reseller. To find the reseller or Mimio sales rep nearest you, visit http://www.mimio.com/en-
NA/Purchase/Resellers.aspx. 

Q: Could I use a mix of Android and Apple devices, and could they be used at the same time? 

A: Yes, you can use any combination of Android and Apple devices at the same time. The MimioMobile 

app supports iPad 2, iPad 3, iPad 4, iPad mini devices, iPhone (4th generation and higher), iPod Touch 

(4th generation and higher), and Android 3.0 (Honeycomb) tablets and smartphones. You can learn all 

about using the MimioMobile app in your classroom in our free MimioTraining Quick Learn session, 

Mimio Goes Mobile: http://www.mimio.com/en-NA/Training/QuickLearn-Overview.aspx 

 

Q: Do students have to pay a license fee for the MimioMobile app? 
A: No. The app for student devices is absolutely free and can be installed on each and every mobile 
device. You can use up to three mobile devices with no additional license, or you can purchase the 
MimioMobile classroom license so that all student mobile devices can connect. 

Q: Where can I find the random number generator buttons?  
A: A link to a Gallery of random number generators is here: 
http://www.mimioconnect.com/content/lesson/random_number_generator_gallery 
You can also search mimioconnect.com, using keywords for others.   

Q: How do you make the multiple questions so large? 
A: When you insert a MimioVote question template from the MimioStudio Gallery, you can modify the 
question to fit your needs.  To make the question larger, simply click on any corner of the question and 
drag to the size you find most convenient.  Learn how to use the MimioVote assessments in our Quick 
Learn sessions or On-Demand Video Tutorials under the “Setup” section. 

http://www.mimio.com/en-NA/Purchase/Resellers.aspx
http://www.mimio.com/en-NA/Purchase/Resellers.aspx
http://www.mimio.com/en-NA/Training/QuickLearn-Overview.aspx
http://www.mimioconnect.com/content/lesson/random_number_generator_gallery
http://mimio.com/QuickLearn
http://mimio.com/QuickLearn
http://www.mimio.com/en-NA/Training/On-Demand-Video-Tutorials.aspx
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Q: I am looking for a math symbol pack to use in self-paced tests.  When I print the test from Mimio, 
the symbols don’t show up.  Any ideas?  
A: The best starting point to look for additional content is MimioConnect. One resource would be 
http://www.mimioconnect.com/content/lesson/11442/math_symbol_generator. As for images printing 
off when you generate a self-paced test, images will not appear.  As a work around, it is suggested 
create your tests in a test bank software package or Microsoft Word.  You will have complete control of 
the layout and the design.  In MimioStudio, you could then just add question templates to each slide and 
enter only the answers to your questions that are printed on the test.  You would not need to enter the 
questions or answer choices in MimioStudio.  Essentially, you are creating an answer key.  When you 
begin the self-paced test with your students that are using the printed off test, it will all match up as 
long as your answer key matches the test. If you have further questions on this process, contact us at 
training@mimio.com. 

Q: Can I upload a document (Word, PDF, etc) to a new page in MimioStudio and then use the tools 
that are available.  
A: This is one of the most valuable features of the MimioStudio software that allows you to use your 
existing lesson resources without reinventing.  You can insert Word documents, PDFs, PowerPoint files, 
images, audio, Flash files, and other interactive whiteboard files.  Simple click on the Insert > File button 
in the top menu.  Browse to the resource located on your computer.  The file will be inserted into 
MimioStudio giving you the power to use any of the MimioStudio tools as well as add you own 
interactive elements to the lesson.  Find out more in our On-Demand Video Tutorials under the “Adding 
Content” section.  

Q: How do the objective box and animated objects work? How do you animate items? 
A: The objective box and other objects are usually a combination of items. For the objective boxes 
demonstrated, you first must create a text box and enter the objective or text of your choosing. You can 
then change the border of the text box to a color other than white, or use a Shape tool and draw a box 
around the text. If you do the latter, you’ll need to select both the text box and the shape, and group 
them together. Set the text box on the page where you want it ultimately to be. Then select the text box 
and animate it. Do this by right-clicking and choose Animate, or Insert > Animate. You will then be able 
to select from a list of animations. If you want it to slide in as demonstrated, you’ll select one of the 
“slide in from...” options. You can also then select one of the Triggers at the bottom. “Triggers” refers to 
the icon that will be attached to the text box that you’ll click on. The three Triggers are Default (grey 
triangle icon), Results (graph icon), and Notes (question mark icon). We typically use the Notes option 
for objective boxes. Click OK to set it. If you click on the icon that was created, the object you animated 
will move into the position where you set it. You’ll notice a blue border around the object. This indicates 
that it’s an interactive element of your page, and you’ll want to lock it to make the blue border go away. 
Select your newly animated object, right-click, and choose Lock or Format > Locking > Lock. 

Learn more about the Animate tool in our Quick Learn session MimioStudio: Formatting II. 
http://mimio.com/QuickLearn    

Q: How do I become a member of MimioConnect? 
A: It’s easy! Visit MimioConnect and click on “Click Here to Register” under the Why Become a Member 
section on the right.  Enter some brief information about yourself, select a username and password, and 
you are set to explore all the wonders of MimioConnect.  Learn more about how to maximize the 
resources of MimioConnect in our On-Demand Quick Learn recording. 

http://www.mimioconnect.com/content/lesson/11442/math_symbol_generator
mailto:training@mimio.com
http://www.mimio.com/en-NA/Training/On-Demand-Video-Tutorials.aspx
http://mimio.com/QuickLearn
http://www.mimioconnect.com/
http://www.mimioconnect.com/user/register
https://mimio.adobeconnect.com/p90qk5he6qz/
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Q: How do I learn how to bring Flash resources into MimioStudio ? 
A: There are many web-based resources that are created in the Flash programming language.  You can 
use your Mimio Classroom products such as the MimioTeach to interact with anything on your 
computer.  Sometimes, it’s convenient to bring those Flash resources into your MimioStudio lessons.  
While not all Flash resources are created equal, many can be saved from websites and brought into 
MimioStudio.  Here’s a link to a resource on MimioConnect that may provide some insight into the 
process.  Keep in mind, as technology and web-browsers evolve, some methods may no longer work.   

http://www.mimioconnect.com/content/lesson/increasing_interactivity_flash_animation 
 
Q: How does one become a MimioMaster? 
A: Mimio offered a MimioMaster and Mimio Certified Training program in the past.  Due to realignment 
of some of our programs, these programs are currently suspended.  It is our intent to offer these again 
in the future based upon interest and needs in the educational community.  Any future offerings would 
be communicated on our Training page, Blogs, and email campaigns in the future. 

 

For Your Information: 

Register for future webinars or watch recordings of previous webinars:  
mimio.com/webinar  

Overview of online and on-demand Mimio training resources:  
mimio.com/en-NA/Training/Overview.aspx  

MimioTraining Quick Learn Training Sessions:  
mimio.com/QuickLearn  

Mimio Webinar Series Certificate of Completion:  
Link is provided in the webinar recording. 

http://www.mimioconnect.com/content/lesson/increasing_interactivity_flash_animation
http://www.mimio.com/en-NA/Training/Overview.aspx
http://blog.mimio.com/
file:///C:/Users/nwitting/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/Content.IE5/L9LR8BUQ/mimio.com/webinar
file:///C:/Users/nwitting/Documents/Mimio_doc/mimio.com/en-NA/Training/Overview.aspx
http://mimio.com/QuickLearn

